
Interface Reporting Report Pack
Software Version 5.2

HP Performance Insight
User Guide
August 2007
 



Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2003 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.

Windows® and Windows NT® are U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
3



Support

You can visit the HP Software Support web site at:

www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

www.managementsoftware.hp.com/passport-registration.html
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1 Overview
This chapter covers the following topics:

• Introduction to HP Performance Insight

• Enhancements in version 5.2

• Data collection

• Folders and reports

• Rules and actions for thresholds

• Ways to customize reports

• Sources for additional information

HP Performance Insight

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

• Integration with NNM

• Integration with OVO

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For a list of reporting solutions organized by technology, see 
Appendix B, PI Report Packs.
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Interface Reporting

The Interface Reporting Report Pack installs on OVPI. The reports in this package are 
designed to help you maintain service levels, assess capacity constraints, and spot problem 
areas before they become serious. Interface Reporting does the following chores for you, 
automatically:

• Exception monitoring (discard exceptions, error exceptions, utilization exceptions)

• Ranking (spot the extremes — trunks, locations, protocols that rank in the top ten) 

• Sort interfaces by rate of growth over the rolling baseline period

• Highlight devices that are expected to exceed utilization thresholds in the near future

• Estimate future utilization based on behavior during the baseline period

• Correlate future performance by day-of-week

• Show performance for a device, trunk, or EtherChannel in near real time

• Compare today’s activity to yesterday

• Compare today’s activity to last week and last month

• Compare last month’s activity to previous months

Enhancements in Version 5.2

Version 5.2 includes new features, new upgrade packages, and defect fixes. 

New Features

• Location Independent Reporting (LIR)

• Supports Management Console > Copy Policy Manager

• Report format updates

• Long Term Retention (data archiving)

• Supports Management Console > Delete Managed Object Wizard

New Upgrade Packages

• UPGRADE_Interface_Reporting_to_52.ap

• UPGRADE_Interface_Reporting_Device_50_to_51.ap

• UPGRADE_Interface_Reporting_Location_50_to_51.ap

The Delete Managed Object Wizard allows the user to:

• Remove an object and all the data associated with that object 
• Remove old data and stop collecting new data 
• Stop collecting data for an object 
• Remove old data for an object 
Removing an object or stopping a collection updates an exclusion table. To prevent IR from 
inserting data into the KIRDEVPORTS property table after you deleted an object or stopped 
data collection, a map procedure was updated. The updated map procedure checks an object’s 
exclusion status before creating new objects in KIRDEVPORTS.
8 Chapter 1



• UPGRADE_Interface_Reporting_Protocol_50_to_51.ap

• UPGRADE_Interface_Reporting_Vlan_50_to_51.ap

The latest release of report packs includes several new upgrade packages for datapipes. These 
packages will make installation easier, since uninstalling the old datapipe, then re-installing 
the new version will no longer be necessary. The new datapipe upgrade packages are:

• UPGRADE_CiscoVLAN_Datapipe_to_22.ap

• UPGRADE_IFEntry_Disc_Datapipe_to_24.ap

• UPGRADE_IRifEntry_Datapipe_to_24.ap

For a list of the defects fixed in version 5.2, see Appendix A, Version History.

Data Collection

The following datapipes can be used with Interface Reporting:

Interface Reporting ifEntry Datapipe 2.4 (required)

Collects data from the MIB-II ifTable in accordance with the polling rule you implement. If 
desired, you can configure this datapipe to perform directed-instance polling. Also known as 
flagged interface polling, directed-instance polling allows you to specify which interfaces you 
want to poll. If your network includes hundreds or possibly thousands of ports feeding desktop 
users, and your initial goal is to collect data from a few LAN switch interfaces (the server 
ports or the uplink ports), you can use directed-instance polling to restrict data collection to a 
smaller subset of interfaces, thereby enhancing performance and scalability.

Interface Discovery Datapipe 2.4 (required)

Discovers and tracks MIB-II ifTable interface identifiers and configuration data. This 
datapipe does not poll. It is a prerequisite for several other datapipes, including the IR ifEntry 
Datapipe.

Interface Reporting Duplex Datapipe 2.0 (optional)

Polls the RFC2665 MIB for OID 1.3.6.1.2.1.10.7.2.1.19, which indicates the status, full or half 
duplex, of an interface. The value pulled from the MIB overrides the default for that protocol 
type.

Interface Reporting Cisco VLAN Datapipe 2.2 (optional)

Collects VLAN configuration information for the VLAN reports in the IR VLAN package.

Interface Reporting OPNET Export Datapipe 2.1 (optional)

Exports MIB-II ifTable data in a format compatible with OPNET.

Folders and Reports

The Interface Reporting Report Pack includes the following report folders:

• Admin

• Device

• EtherChannel
Overview 9



• Interface

• Location

• Protocol

• VLAN

Reports in the Device, Location, Protocol, and Vendor folders have a customer orientation. 
Your first step is to select a customer. Selecting a customer displays a list of devices, locations, 
protocols, or vendors that belong to the customer. 

The only data in a customer-oriented report is aggregated data. The Device folder aggregates 
data by device, which means that data for all enabled interfaces (administratively up 
interfaces) has been rolled up to the device level. Similarly, the reports in the Location folder 
roll up data for enabled interfaces by location, while reports in the Protocol folder roll up data 
for enabled interfaces by protocol.

Reports in the Interface folder have an interface orientation. Each report begins with a table 
containing a list of devices in column 1 and a list of interfaces in column 2. 

Folder Folder Contents

Admin • Configuration & Logging
• Inventory
• System Performance
• Top Level Inventory

Interface • Availability Detail
• Capacity Planning 
• Discard Exceptions 
• Error Exceptions
• Exception Hot Spots 
• Grade of Service
• Utilization and Volume
• Near Real Time
• Near Real Time Snapshot
• Service Level Management
• Simple NRT
• Top Ten 
• Unreachable
• Utilization Exceptions

Device • Capacity Planning
• Exception Hot Spots
• Priority Customer
• Service Level Management
• Top Ten

VLAN • Exception Hot Spots
• Near Real Time
• Top Ten
• Traffic Utilization
10 Chapter 1



Types of Reports

See below for a brief description of each type of report.

Availability Detail. Displays a list of interfaces that were unavailable for at least part of the 
previous day.
Capacity Planning. Forecasts busy-hour utilization and sorts interfaces, devices, locations, 
protocols, or vendors by rate of growth.
Configuration and Logging. Displays configuration settings that determine how 
collections are performed; displays an entry for each transfer from the datapipe to the report 
pack, indicating when the transfer took place and the number of rows that were mapped to 
the report pack.
Exceptions. Identifies the interfaces with the highest number of discard exceptions, error 
exceptions, or utilization exceptions.
Exception Hot Spots. Identifies the trunks, interfaces, VLAN interfaces, and devices with 
the highest number of exceptions.
Executive Summary. Aggregates volume, exception counts, and utilization by protocol, 
location, or vendor.
Grade of Service. Identifies the ten worst performing interfaces and assigns a grade to each 
interface based on utilization, error, and discard exceptions.

Inventory. Shows which devices are provisioned and property data associated with devices 
and interfaces. Top Level Inventory shows the total number of devices for each customer, the 
total number of interfaces for each customer, and a breakdown by make and model.

Etherchannel • Exception Hot Spots
• Near Real Time

Location • Capacity Planning
• Executive Summary
• Priority Customer
• Service Level Management
• Top Ten

Protocol • Capacity Planning
• Executive Summary
• Service Level Management
• Top Ten
• Priority Customer

Vendor • Capacity Planning
• Executive Summary
• Make and Model Top Ten
• Priority Customer
• Service Level Management
• Top Ten

Folder Folder Contents
Overview 11



Near Real Time. Provides utilization, error, and discard data for active interfaces, trunks, 
and EtherChannels; the time period begins with the most recent poll and goes back six hours; 
drill-down to daily and monthly data.
NRT Snapshot. Provides utilization, error, and discard data for one device, multiple devices, 
or specific interfaces on one device; same time period as Near Real Time.

Priority Customer. These reports provide availability, exception and volume metrics for 
selected high priority customers and their managed elements. They are suitable for wall 
board displays with an hourly refresh, allowing management and staff to see the current state 
of their network from a customer perspective at a high level. No data will appear in these 
reports unless you assign Priority to the customer/device, customer/location, customer/
protocol or customer/vendor combinations using the Assign Priority forms under General Tasks 
in the Property/Object Manager window.

Service Level Management. Identifies interfaces, devices, locations, protocols, and vendors 
with lowest availability and highest response time.
Simple Near Real Time. A subset of Near Real Time; provides statistics for the previous six 
hours and an hourly view of utilization, discards, and errors. Intended for easy integration 
with the NMS.
System Performance. Measures duration, in seconds, for groups of related tasks performed 
by the report pack.
Top Ten. Identifies interfaces, VLAN interfaces, trunks, devices, locations, protocols, and 
vendors with the highest volume and the lowest volume.
Unreachable. Provides a list interfaces for which no data has been received for 35 minutes; 
excludes interfaces for which no data has been received for more than six hours.

Rules and Actions for Thresholds

You can enhance fault isolation and problem diagnosis by integrating NNM and OVPI. If 
NNM and OVPI are integrated, the NNM operator will have access to the Report Launchpad 
window. From the Report Launchpad window, the NNM operator can launch any report in 
Interface Reporting. 

If NNM and OVPI are integrated, be sure to install the optional thresholds sub-package that 
comes with Interface Reporting. The optional thresholds sub-package contains a thresholds 
policy for the Thresholds Module. The thresholds policy defines:

• Threshold conditions specific to Interface Reporting

• An action for OVPI to take when a threshold is breached

• An action for OVPI to take when a breach condition returns to normal

Configuring the Thresholds Module is not necessary. You do not need to configure thresholds, 
define actions, or specify a destination for threshold traps. However, you may modify category, 
severity, and destination parameters at any time. For details about these options, refer to the 
Thresholds Module User Guide.
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The following table provides details about the thresholds policy contained in the optional 
thresholds sub-package.

The thresholds in the preceding table are defaults. You can easily modify any default on a 
per-interface basis by using the Change Interface Properties form. For details about this form, 
see Chapter 7, Change Forms.

Ways to Customize Reports

Reports can be customized by importing properties (customers and locations), by applying 
group filters, by applying constraints, by editing tables and graphs, and by adding details 
about interface attributes. While creating group filters is a task for an administrator, any user 
looking at a report can apply constraints or edit tables and graphs. For details about view 
options for tables and graphs, see Appendix C, Editing Tables and Graphs.

Threshold Data Type Description  Severity

InDiscards NRT In Discard percentage exceeds discard 
exception level.

Warning

OutDiscards NRT Out Discard percentage exceeds 
discard exception level.

Warning

InErrors NRT In Error percentage exceeds error 
exception level.

Minor

OutErrors NRT Out Error percentage exceeds error 
exception level.

Minor

InUtilization NRT In Utilization percentage exceeds 
utilization exception level.

Warning

OutUtilization NRT Out Utilization percentage exceeds 
utilization exception level.

Warning

Availability NRT Availability less than exception level. Warning

UtilException  Hourly Utilization exceeds threshold in more 
than 45% of samples.

Warning

DiscardsException  Hourly Discards exceed threshold in more 
than 45% of samples.

Warning

ErrorsException  Hourly Errors exceed threshold in more than 
45% of samples.

Minor

InUtilForecast Daily 30 day forecast In Utilization exceeds 
utilization exception level.

Warning

OutUtilForecast Daily 30 day forecast Out Utilization 
exceeds utilization exception level.

Warning
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Group Filters

If you want to share reports with customers, you must produce customer-specific reports. To 
produce customer-specific, perform these tasks:

• Use Common Property Tables to import properties (customer names and device locations)

• Create a group account for all of the users affiliated with each customer

• Create a group filter for the group account

For more information group filters, refer to the OVPI Administration Guide. 

Applying Constraints

Editing a parameter applies a constraint. The constraint eliminates the data you are not 
interested in seeing. If you edit the Customer Name parameter, data for every customer 
except the customer you typed in the Customer Name field drops from the report. You can 
apply multiple constraints at the same time. Interface Reporting supports the following 
parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Make

• Model

If you are using the Web Access Server to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Importing Properties

You have the option of populating reports with node-level properties and interface-level 
properties. Node-level properties are sourced from Common Property Tables. Interface-level 
properties can be sourced from the network, or read from a property import file that you 
create yourself from scratch. If you prefer, you can also export existing property data from 
OVPI, modify what you get from OVPI, and then re-import this file with your changes. The 
following forms are available for updating properties:

• Change Protocol Defaults

• Change Interface Properties

• Change Interface Customer

• Change Interface Location

• Change Interface Description

• Administer Interface Poll Flag
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The Administer Interface Reporting form does not pertain to object properties. Use it to 
modify the behavior of the package itself.

Sources for Additional Information

This guide includes samples of some reports. The demo package that comes with Interface 
Reporting contains a sample of every report in the package. If you have access to the demo 
package, and you want to know what fully-populated reports look like, install the demo 
package. Demo reports are interactive, but unlike real reports the data in a demo report is 
static.

For information regarding the latest enhancements to Interface Reporting and any known 
issues, refer to the Interface Reporting Report Pack Release Notes. You may also be interested 
in the following documents: 

• Cisco VLAN Datapipe Release Notes

• Common Property Tables User Guide

• Executive Summaries Report Pack User Guide

• Interface Discovery Datapipe User Guide

• Interface Reporting ifEntry Datapipe User Guide

• NNM/PI Integration User Guide

• OVPI Report Packs, CD-ROM Release Notes, April 2007

• Thresholds Module User Guide

The user guides for the core product, Performance Insight, and the user guides for the 
reporting solutions that run on Performance Insight, can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Each document 
indicates a date. If a document is revised and reposted, the date will change. Since we post 
revised manuals on a regular basis, you should compare your PDF to the web edition and 
download the web edition if it is newer.
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2 The Upgrade Install
This chapter covers the following topics: 

• Guidelines for a smooth upgrade

• Upgrading to Interface Reporting 5.2

• Uninstalling Interface Reporting 

Guidelines for a Smooth Upgrade

The report pack CD contains report packs, datapipes, and several shared packages. To extract 
these packages from the CD to the Packages directory on your system, insert the report pack 
CD in the CD-ROM drive and launch the package extraction program. When the extract 
finishes, the install script will prompt you to launch OVPI and start Package Manager. 

If the package extraction step has already taken place, all of the packages associated with 
Interface Reporting, including the latest upgrade packages, are in the Packages directory on 
your system awaiting installation. To upgrade Interface Reporting, start Package Manager 
and follow the on-screen instructions. Before beginning the upgrade, be familiar with the 
following topics:

• Prerequisites for Interface Reporting 5.2

• Datapipes and remote pollers

• Custom table views

• Upgrading Interface Reporting in a distributed environment

Prerequisites for Interface Reporting 5.2

Make sure the following software is already installed before upgrading Interface Reporting:

• OVPI 5.2

• All available service packs for OVPI 5.2

• Interface Reporting 5.1

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information is lost:

• Single polling policy for a remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 
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To prevent this information from being lost, export existing polling policy configurations and 
customized polling groups by using the following commands:

• collection_manager

• group_manager 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom table views, the views you created may interfere with the report pack 
upgrade, causing the upgrade to fail. Whether or not your views interfere with the upgrade 
process depends on how you created them. If you created them using SQL, the upgrade will 
succeed, however, your views will not be available once the upgrade is complete. If you created 
them using Datapipe Manager, the upgrade is likely to fail. To prevent the upgrade from 
failing, delete the views you created before you upgrade the report pack, then, after the report 
pack is upgraded, recreate your custom views.

Distributed Environments

If you are running OVPI as a distributed system, every server must be running OVPI 5.2 and 
all the Service Packs available for OVPI 5.2. Here is an overview of the installation procedure 
for distributed environments:

1 Disable trendcopy on the central server.

2 For the central server:

• Upgrade to Interface Reporting 5.2; deploy reports.
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• Upgrade the device, location, protocol and VLAN sub-packages to 5.1; deploy reports.

• Re-edit the process files containing trendcopy directives for Device, Location and 
Protocol; these files were overwritten during the upgrade process.

3 For each satellite server:

• Upgrade to version 5.2; deploy reports.

• Upgrade the device and thresholds sub-packages.

• Remove these datapipes:

— Interface Reporting Duplex Datapipe

• Install these datapipes:

— IRifEntry Duplex Datapipe 2.0

• Install these datapipe upgrades:

— UPGRADE_CiscoVLAN_Datapipe_to_22

— UPGRADE_IFEntry_Disc_Datapipe_to_24

— UPGRADE_IRifEntry_Datapipe_to_24

— UPGRADE_IR_OPNET_Export_Datapipe_to_21

4 Re-enable trendcopy on the central server.

5 Reconfigure the central server and each satellite server. For details, see Chapter 4, 
Setting Up a Distributed System.

Upgrading to Version 5.2

Perform the following tasks to upgrade to Interface Reporting 5.2:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: If necessary, upgrade to Common Property Tables 3.6

• Task 3: Install the Interface Reporting “to_52” upgrade package

• Task 4: If necessary, install the “to_51” sub-packages

• Task 5: Install the upgrade packages for datapipes that have upgrade packages

• Task 6: Uninstall the Interface Reporting Duplex datapipe 

• Task 7: Install the new version of the IRifEntry Duplex datapipe 

• Task 8: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

If reports are currently deployed from satellite servers, you would 
also want to upgrade the location, protocol and VLAN 
sub-packages.

If you are using the “Poll Flagged Interfaces Only” polling rule, you must 
re-provision the poll flag after this upgrade. Refer to the Interface Reporting 
ifEntry Datapipe User Guide for details.
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2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD. On Windows, a Main Menu displays automatically; on UNIX, 
mount the CD if the CD does not mount automatically, navigate to the top level directory 
on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.

Once the extract is finished, the Interface Reporting folder under the Packages directory on 
your system will contain the following folders:

• Docs

• Interface_Reporting.ap

• Interface_Reporting_Demo.ap

• Interface_Reporting_Device.ap

• Interface_Reporting_Location.ap

• Interface_Reporting_Protocol.ap

• Interface_Reporting_Thresholds.ap

• Interface_Reporting_Vlan.ap

• UPGRADE_Interface_Reporting_Device_50_to_51.ap

• UPGRADE_Interface_Reporting_Location_50_to_51.ap

• UPGRADE_Interface_Reporting_Protocol_50_to_51.ap

• UPGRADE_Interface_Reporting_to_52.ap

• UPGRADE_Interface_Reporting_Vlan_50_to_51.ap

Task 2: Upgrade to Common Property Tables 3.6

If you have not upgraded to Common Property Tables 3.6, do this now. Observe these rules:

• Do not install other packages at the same time; install the upgrade package for Common 
Property Tables and only the upgrade package for Common Property Tables.

• When the Report Deployment window opens, accept the default to Deploy Reports. In this 
context, deploying reports means deploying the forms that come with Common Property 
Tables. 

• When the install completes, click Done to return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables User Guide. 

Task 3: Install UPGRADE_Interface_Reporting_to_52

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.
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3 Click Install. Approve the default installation directory or select a different directory if 
necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; type your user name and 
password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

UPGRADE_Interface_Reporting_to_52

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

9 Click Done to return to the Management Console. 

Task 4: Install the “to_51” sub-packages for Location, Device, Protocol, VLAN

Installing the Interface Reporting Thresholds sub-package is optional. If you install Interface 
Reporting Thresholds, Package Manager will install the Thresholds Module, a prerequisite 
package, for you. 

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; type your user name and 
password for the application server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

a UPGRADE_Interface_Reporting_Device_50_to_51

b UPGRADE_Interface_Reporting_Location_50_to_51

c UPGRADE_Interface_Reporting_Protocol_50_to_51

d UPGRADE_Interface_Reporting_Vlan_50_to_51

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

9 Click Done. 

Do not be surprised if the UPGRADE packages you just installed disappear 
from view. Package Manager will display what you just installed as Interface 
Reporting 5.2. This is not an error.
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Task 5: Install the upgrade packages for the datapipes that have upgrade packages.

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; type your user name and 
password for the application server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

a UPGRADE_CiscoVLAN_Datapipe_to_22.ap

b UPGRADE_IFEntry_Disc_Datapipe_to_24.ap

c UPGRADE_IRifEntry_Datapipe_to_24.ap

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

9 Click Done.

Task 6: Uninstall the old version of the IR Duplex Datapipe.

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Uninstall.

4 Click Next. The Report Undeployment window opens. Accept the default for Undeploy 
Reports; accept the defaults for application server name and port; type your user name 
and password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

Interface_Reporting_Duplex Datapipe

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens.

8 Click Uninstall. The Progress window opens and the removal process begins. When removal 
finishes, a package removal complete message appears.

9 Click Done. 

Task 7: Install the new version of the IR Duplex Datapipe

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

If your system is distributed, this task pertains to satellite servers, not the central server.

If you are using the “Poll Flagged Interfaces Only” polling rule, you must re-provision the poll 
flag after this upgrade. Refer to the Interface Reporting ifEntry Datapipe User Guide for 
details
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3 Click Install. 

4 Click Next. The Report Deployment window opens. Disable the default for Deploy Reports.

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

IRifEntry_Duplex_Datapipe 2.0

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears.

9 Click Done. 

Task 8: Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Package Removal 

If you uninstall the Interface Reporting package, the IR ifEntry Datapipe will be removed 
automatically. Uninstalling the Interface Reporting package does not affect the Interface 
Discovery Datapipe. Follow these steps to uninstall Interface Reporting:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Launch Performance Insight and start Package Manager. The Package Manager welcome 
window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If you deployed the reports in Interface Reporting from this server, accept the defaults for 
Undeploy Reports, Application Server Name, and Port. Otherwise, clear the check box and 
skip to step 9.

8 Type the username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens. Click the check box next to the following 
packages:
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a Interface Reporting 

b Interface Reporting Device 

c Interface Reporting Location 

d Interface Reporting Protocol 

e Interface Reporting Thresholds 

f Interface Reporting Vlan

g Interface Reporting Demo 

10 Click OK. 

11 Click Next. The Selection Summary window opens. 

12 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

13 Click Done.

14 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install
This chapter covers the following topics: 

• Guidelines for a smooth installation

• Installing and tuning Interface Reporting

• Accessing deployed reports

• New object categories in the object model

• Seeing performance data in reports

• Package removal

Guidelines for a Smooth Installation

An OVPI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install a datapipe, you configure OVPI to 
collect a specific type of performance data at a specific interval. When you install a report 
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

If the packages on the report pack CD-ROM were extracted to the Packages directory on your 
system, Interface Reporting is available for installation. If packages were not extracted from 
the report pack CD, follow the extract procedure in this chapter. Once the extract is done, you 
can install Interface Reporting by starting Package Manager and following the on-screen 
instructions. Before using Package Manager, review the following guidelines related to 
prerequisites, Common Property Tables, and distributed environments.

Prerequisites Related to OVPI

Follow these steps to ensure that the prerequisites are in order before proceeding further:

1 Make sure the following software is already installed:

• OVPI 5.2

• All available Service Packs for OVPI 5.2

This chapter does not discuss database configuration, sizing, or tuning. For help with 
those tasks, see the OVPI Installation Guide. If you need help installing a Service Pack, 
refer to the release notes that were issued with the Service Pack.

2 Turn off OVPI Timer. If OVPI Timer is not turned off, the system will begin doing things 
before you finish tuning the report pack.   

3 Using one of the following techniques, populate your node list:

• Do it manually

• Run OVPI SNMP discovery 
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• Import a list of nodes exported from another application (for example, NNM)

• Add the nodes to a file and use node_manager.exe to import the file

Prerequisites Related to SNMP Polling

1 Open the SNMP Edit Profile window (Polling Policy Management > Edit > SNMP Profiles) and edit 
the following fields:

a Increase the default for OIDs-per-PDU.

The default for the number of OIDs-per-PDU is 20. IR’s raw collection polls 28 OIDs. 
Unless the OIDs per PDU is adjusted, OVPI will send two PDUs to the polled device. 
Changing the default to 30 OIDs per PDU can cut in half the number of packets sent 
to each device.

b Reduce the default for the SNMP timeout.

If you have a reliable, high-speed network, reduce the timeout default. Reducing the 
default will shorten the polling window.

c Lower the default for SNMP retries.

If you have a reliable, high-speed network, do not keep retrying a non-responsive 
device. The default, 5 retries, is usually overkill. Drop this down to 1 or even 0. Better 
to lose a poll for a device than to keep retrying an unavailable device.

2 Increase the default for the number of child pollers.

The SNMP poller is mw_collect. Mw_collect spawns one child poller for each polled device. 
The default is 5 child pollers, which is analogous to a process window that sustains 5 
active child pollers at any one time, initiating a new child poller as soon as the preceding 
child poller completes. 

The number of child pollers is controlled by the “-c” argument. To make polling more 
efficient, increase the number of child pollers (to 25, 35, or even 50) by editing the 
following file:

$DPIPE_HOME/lib/trendtimer.sched

Edit the file by adding “-c n” to the mw_collect entries for 5, 10, 15, 20, 60, 1440-minute 
invocations. 

3 Activate SNMPv2 GETBULK retrieval.

OVPI provides GETBULK retrieval for SNMPv2 (snmpv2c) collections. Using GETBULK 
can significantly reduce the number of SNMP PDUs that OVPI sends to target nodes. 
Reducing the number of SNMP PDUs makes polling more efficient and may, depending on 
how the vendor’s SNMP agent was implemented, reduce the load on polled devices.

To activate SNMPv2 GETBULK, add the “-e” argument to mw_collect. For example:

5 – {DPIPE_HOME}/bin/mw_collect –m –i 5 –K 1 –c 250 –e 

i

Not all SNMP agents permit large request packets. If the agent does not allow 28 
OIDs, you may see a message indicating that your request packet is too large. Your 
options are to send more packets that are smaller, or create a separate SNMP 
profile that reduces the OID count, and assign that policy to the nodes that cannot 
sustain the 30-OID policy.

use

The default for OIDs-per-PDU is set by OVPI. Upcoming releases of OVPI may use 
a different default. If the default is correct, no changes are necessary.
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10 – {DPIPE_HOME}/bin/mw_collect –m –i 10 –K 1 –c 250 –e 

15 – {DPIPE_HOME}/bin/mw_collect –m –i 15 –K 1 –c 250 –e 

20 – {DPIPE_HOME}/bin/mw_collect –m –i 20 –K 1 –c 250 –e 

60 – {DPIPE_HOME}/bin/mw_collect –m –i 60 –K 1 –c 250 –e

Common Property Tables

If you are running an older version of Common Property Tables, version 3.5 or earlier, 
upgrade to version 3.6. If you are not running any version of Common Property Tables, let 
Package Manager install the latest version of Common Property Tables for you. Do not install 
the upgrade for Common Property Tables and other packages at the same time. Install the 
upgrade for Common Property Tables and only the upgrade for Common Property Tables. For 
more information about installing and using Common Property Tables, refer to the Common 
Property Tables User Guide.

Distributed Environments

If you intend to run Interface Reporting as a distributed system, every server must be 
running the same version of OVPI as well as all available Service Packs for that version. An 
outline of the installation procedure follows.

Central Server

Install the following packages on the central server: 

• Interface Reporting

• Device sub-package

• Location sub-package

• Protocol sub-package

• VLAN sub-package

When installing these packages on the central server, deploy reports. 

Satellite Servers

Install the following packages on each satellite server:

• Interface Reporting

• Device sub-package

• Location sub-package (optional)

• Protocol sub-package (optional)

• VLAN sub-package (optional)

• Interface Reporting Thresholds (optional)

• Interface Discovery Datapipe 2.4

• Interface Reporting ifEntry Datapipe 2.4

• Cisco VLAN Datapipe 2.2 (optional)
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• OPNET Export Datapipe 2.1 (optional)

When installation is complete, your next step is to set up connections with satellite server 
databases, configure trendcopy pull commands, and switch off daily and monthly aggregations 
at each satellite server. For details, see Chapter 4, Setting Up a Distributed System. 

Installing and Tuning Interface Reporting

This section covers the following tasks:

• Task 1: Extract packages from the report pack CD

• Task 2: If necessary, upgrade to Common Property Tables 3.6

• Task 3: Install Interface Reporting and both datapipes

• Task 4: Turn off polling policies for the IR ifEntry Datapipe

• Task 5: Use the IR_Config.pl utility to check and adjust polling rules

• Task 6: Use the Administration form to set the provisioning mode

• Task 7: Restart OVPI Timer 

• Task 8: De-activate unwanted ifTypes (protocols) and adjust default thresholds.

• Task 9: Turn back on the polling policies you turned off in Task 4.

• Task 10: Provision customers and locations

• Task 11: Export provisioning data from OVPI for safekeeping

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 If OVPI Timer process is running, stop it and wait for processes to terminate.

Windows:

a From the Control Panel, select Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays 
automatically; on UNIX, mount the CD manually if the CD does not mount automatically, 
then run the setup command. 

One of the polling rule options you can implement using the IR_Config.pl utility is Poll Flagged 
Interfaces Only. If your network includes hundreds or possibly thousands of ports feeding 
desktop users, you can use the flagged interfaces only option to restrict data collection to a 
smaller subset of interfaces, thereby enhancing performance and scalability. For details, refer 
to the IR ifEntry Datapipe User Guide.
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4 Select OVPI report packs by typing 1 in the choice field and pressing Enter. The install 
script displays a percentage complete bar. When extraction is complete, the install script 
starts Package Manager. The Package Manager welcome window opens.

Once the extract is finished, you can navigate to the Interface Reporting folder, under the 
Packages directory, to see the packages that are available for installation. The Interface 
Reporting contains the following sub-folders:

• Docs

• Interface_Reporting.ap

• Interface_Reporting_Demo.ap

• Interface_Reporting_Device.ap

• Interface_Reporting_Location.ap

• Interface_Reporting_Protocol.ap

• Interface_Reporting_Thresholds.ap

• Interface_Reporting_Vlan.ap

• UPGRADE_Interface_Reporting_Device_50_to_51.ap

• UPGRADE_Interface_Reporting_Location_50_to_51.ap

• UPGRADE_Interface_Reporting_Protocol_50_to_51.ap

• UPGRADE_Interface_Reporting_to_52.ap

• UPGRADE_Interface_Reporting_Vlan_50_to_51.ap

You can ignore the upgrade packages. Installing the demo package is optional.

Task 2: Upgrade Common Property Tables 

This task is necessary only if you are currently running an older version of Common Property 
Tables. Upgrade to version 3.6 by installing the upgrade package. Observe these rules:

• Install the upgrade by itself; install no other packages. 

• When the Report Deployment window opens, accept the default to Deploy Reports. By 
deploying reports, you will also deploy the forms that come with Common Property Tables.

• When the install finishes, click Done to return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables User Guide.

Task 3: Install Interface Reporting and both datapipes

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the default for application server name and port; type the username and password 
for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 
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6 Click the check box next to the following packages:

a Interface Discovery Datapipe 

b Interface Reporting ifEntry Datapipe 

c Interface Reporting Duplex Datapipe 

d Cisco VLAN Datapipe (optional)

e OPNET Export Datapipe (optional)

f Interface Reporting 

g Interface Reporting Device 

h Interface Reporting Location (optional)

i Interface Reporting Protocol (optional)

j Interface Reporting Thresholds (optional)

k Interface Reporting Vlan (optional)

l Interface Reporting Demo

7 Click Next. The Type Discovery window opens. To run Type Discovery immediately after 
package installation, accept the default.

8 Click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install process begins. When 
the install finishes, a package install complete message appears. 

10 Click Done.

Task 4: Turn off polling policies for the IR ifEntry Datapipe

You do not want raw collections to begin until you have configured the report pack for ifType 
monitoring. From the Management Console, open Polling Policy Management and turn off the 
following polling policies for IR collections: 

• ifName_Collection

• ifIndex_Collection

• ifDescr_Collection

• ifAlias_Collection

Task 5: Use the IR_Config.pl utility to check and adjust polling rules 

The IR ifEntry Datapipe includes a configuration tool. Use the configuration tool to adjust the 
polling rule. These are your polling rule options:

• Poll all active interfaces

• Poll all interfaces

• Poll all active interfaces with monitored protocols (default)

• Poll all interfaces with monitored protocols

• Poll flagged interfaces only

at 

If you do not want protocol and location statistics, do not install the protocol and 
location sub-packages. Installing these sub-packages forces the database server to 
allot resources to additional summarizations. 
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If you want to adjust the default, launch the configuration tool (IR_Config.pl) and change it. 
For details about polling flagged interfaces only (also known as directed-instance polling), 
refer to the Interface Reporting ifEntry Datapipe User Guide.

Task 6: If necessary, use the Administration form to change the default provisioning mode

The provisioning mode determines whether values sourced from the network override the 
user, or whether the user overrides values sourced from the network. The default is that 
values set by the user for ifIndex, ifName, and ifDescr will not be over-written by values 
sourced from the network. 

However, if your network is dynamic and if you want to be able to adapt to changes, then the 
default may not be appropriate. To change the default, open the Object Management view and 
select the Administer Interface Reporting form. When the form opens, set the provisioning mode to 1.

Task 7: Restart OVPI Timer

Windows: 

a From the Control Panel, select Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Task 8: Deactivate ifTypes (protocols) you do not want and adjust default thresholds

1 Open the Change Protocol Defaults form. 

2 Deactivate any ifTypes you do not want included in reports by toggling the status from 
monitored to not monitored. If desired, operate in lock-down mode by deactivating all 
ifTypes. If you deactivate all ifTypes, you must enable certain ifTypes later.

3 Adjust default thresholds on a per-ifType basis. When Interface Reporting discovers new 
interfaces on a device, it will add a new row to the KIRDevPorts property table. This new 
row will include the threshold values established by this form.

Task 9: Turn on the polling policies you turned off in Task 4.

Your implementation is properly configured. You are retrieving ifEntry data from the desired 
interfaces, timeouts are not wasting time, SNMP retry requests are not wasting time, and you 
are transmitting the least number of SNMP datagrams required to retrieve the OIDs. It is 
now safe to turn on the polling policies you turned off in Task 4.

Task 10: Provision customers and locations

There is no need to assign a customer and a location to an interface. The interface will inherit 
customer and location from the parent node. If you want to override the inherited values, then 
you must assign a customer and location to the interface.

To assign a parent node to a customer and location, navigate the Object/Property 
Management view, select a node, and open the Update Node Information form under Object 
Specific Tasks.

If you are polling flagged interfaces only, the ifTypes you do not want included in 
reports have already been deactivated.
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Task 11: Export provisioning data from OVPI for safekeeping

Export property information from OVPI. If for any reason you need to uninstall and reinstall 
the report pack, you can use the export file to immediately re-import property information. 

Accessing Deployed Reports

When you installed Interface Reporting, you enabled the Deploy Reports option. As a result, 
the reports in this package (as well as any forms that come with reports) were deployed to the 
OVPI Application Server. Once reports reside on the OVPI Application Server, you can view 
the reports using the OVPI client applications or you can view reports on the Web.

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If you do not have the client applications, then 
you must use the web interface to view reports.

For more information about the clients, refer to the OVPI Installation Guide. For details about 
the Management Console, including how to use the Object/Property Management view to 
launch reports specific to a selected object, refer to the OVPI Administration Guide.

New Object Categories in the OVPI Object Model

The OVPI object model allows you to navigate to an object, perform tasks that pertain to the 
object, or open reports that pertain to the object. Installing a new report pack modifies the 
object model, adding one or more object categories. Installing Interface Reporting adds one 
object category to the object model: interface. 

Selecting any object in the object model, including an interface, causes the right side of the 
Object/Property Management window to refresh. Look for the forms that pertain to the object 
under General Tasks and Object Specific Tasks. Look for the reports that pertain to the object 
under Object Specific Reports. 

Seeing Performance Data in Reports

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. Data begins to appear in this report after three polling cycles. 
Other reports, including any report that begins with an analysis of yesterday’s performance, 
will need at least one full day’s worth of data before results are viewable.

Until data has been collected for several days, the daily charts will be sparsely populated; 
likewise, monthly charts will not have much to offer until data has been collected for several 
months. Because the Capacity Planning report cannot function without maximum busy-hour 
averages derived from data in the baseline period (42 days long), you will have to wait about 
six weeks for reliable forecasting data.

Package Removal

If you uninstall the Interface Reporting package, the Interface Reporting ifEntry Datapipe 
will be removed automatically. Uninstalling the Interface Reporting package will not affect 
the Interface Discovery Datapipe.
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Follow these steps to uninstall Interface Reporting 5.0:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows:

a From the Control Panel, select Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens. If the reports in Interface Reporting 
were deployed from this server, accept the defaults for Undeploy Reports, Application 
Server Name, and Port. Otherwise, clear the check box and skip to step 8.

7 Type your username and password for the OVPI Application Server.

8 Click Next. The Package Selection window opens. Click the check box next to the following 
packages:

a Interface Reporting 

b Interface Reporting Device 

c Interface Reporting Location 

d Interface Reporting Protocol 

e Interface Reporting Thresholds 

f Interface Reporting Vlan

g Interface Reporting Demo 

9 Click OK. 

10 Click Next. The Selection Summary window opens. 

11 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

12 Click Done to return to the Management Console.

13 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
This chapter covers the following topics:

• Checking for proper package installation

• Splitting polling and avoiding duplicate polling

• Central server configuration

• Satellite server configuration

• Synchronizing system clocks

Check for Proper Package Installation

Verify that package installation is correct. The central server requirements are:

• Interface Reporting 5.2

• Interface_Reporting_Device

• Interface_Reporting_Location

• Interface_Reporting_Protocol

• Interface_Reporting_Vlan (optional)

The satellite server requirements are:

• Interface Reporting 5.2

• Interface_Reporting_Device

• Interface_Reporting_Location (optional)

• Interface_Reporting_Protocol (optional)

• Interface_Reporting_Vlan (optional)

• Thresholds sub-package (optional)

• Interface Discovery Datapipe 2.4

• Interface Reporting ifEntry Datapipe 2.4

• Cisco VLAN Datapipe 2.2 (optional)

• OPNET Export Datapipe 2.0 (optional)
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Split Polling and Avoid Duplicate Polling

You must decide how polling will take place and then split the device groups accordingly. 
These are your options for splitting device groups:

• Split polling between the central server, satellite servers, and remote pollers

• Split polling between satellite servers and remote pollers

• Split polling between multiple remote pollers

The situation you must avoid is duplicate polling, which arises when the device groups 
assigned to one server happen to be the same device groups assigned to a different server, or 
to a remote poller. To avoid this problem, split the polling function properly. The polling 
function is split properly when:

• No two servers have the same polling policies and device group lists

• No two remote pollers have the same polling policies and device group lists

• Servers and remote pollers do not share polling policies and device group lists

For more information about polling policies and how to create them, refer to the Interface 
Reporting ifEntry Datapipe User Guide.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: Enable LIR

• Task 3: Add LIR mappings

• Task 4: Verify the automatically generated copy policies

• Task 5: Modify the trendtimer.sched file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select Interface Reporting from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add to list and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied (defined 
in the generated copy policy) is one greater than the data type selected in the LIR mapping. 
For example, if you select an hourly data type, you will generate a daily data copy policy.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the SHIRDevPorts table and that the copy 
type is set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the SHIRDevPorts table and verify the copy type is set to Property and Data.

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select SHIRDevPorts from the pull down list.
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5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Modify the trendtimer.sched file

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

Make the following changes:

• Find and change the following line (modify the daily processing time):

24:00+4:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IR_DevPort_DMF__Process.pro

to

24:00+3:00+40 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IR_DevPort_DMF__Process.pro

• Find and comment out the following line (only if the central server is not a polling server):

1:00+20 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IR_DevPor_Hourly_Process.pro

Configuring a Satellite Server

A satellite server can perform local reporting from the satellite database without the Location 
and Protocol modules. However, if you want a satellite server to perform full reporting, make 
sure that these modules are installed. If the Location and Protocol modules are installed, 
begin this procedure at step 6.

Follow these steps to configure each satellite server.

1 Modify the trendtimer.sched file (found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed).

Find and change the following line (modify the daily processing time):

24:00+4:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IR_DevPort_DMF_Process.pro

to

24:00+3:40 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/IR_DevPort_DMF_Process.pro
38 Chapter 4



2 Modify the IR_DevPort_DMF_Process.pro file (found in the {DPIPE_HOME}/
scripts/ directory where {DPIPE_HOME} is the directory in which OVPI is installed).

Comment out the IR_DMF1 block (comment out the begin:IR_DMF1 wait and 
end:IR_DMF1 lines).

3 Modify the IR_DevPort_Hourly_Process.pro file (found in the {DPIPE_HOME}/
scripts/ directory where {DPIPE_HOME} is the directory in which OVPI is installed).

Uncomment the IR_2 block (uncomment the begin:IR_2 wait and end:IR_2 lines).

4 Using Table Manager, reduce the retention period of the SHIRDevPorts table from 4 days 
to 2 days. 

5 Configure any protocols that should not be monitored to unmonitored.

6 Configure polling policies for the IR ifEntry Datapipe, taking care that each node is polled 
from one system only. Follow these guidelines:

• If remote pollers are being used, avoid duplicate polling by remote pollers, and 
duplicate polling by the satellite server and remote pollers.

• If a satellite server has two or more remote pollers, create separate polling policies for 
each poller and use view groups to separate the devices.

• Each poller must have 13 polling policies associated with it:

— 1 for the RIRRouterSystem table

— 8 for the Interface Discovery Datapipe

— 4 for the Interface Reporting ifEntry Datapipe

If you need help configuring polling policies, refer to the Interface Reporting ifEntry Datapipe 
User Guide. See Chapter 3, Datapipe Configuration.

Synchronizing System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.
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5 Importing Properties
This chapter covers the following topics: 

• Static property information

• Protocol-specific monitoring

• The batch-mode property import

• Adding details about vendors and models

Static Property Information

Interface Reporting has the ability to store and process static property information as well as 
rapidly changing performance data. Following is an alphabetical list of the properties that 
may appear in reports:

1 Country

2 Customer

3 Description

4 Device Name

5 Device Type

6 Discard Threshold

7 Error Threshold 

8 Full or Half Duplex

9 Group ID

10 Group Name

11 Interface Description

12 Interface Speed

13 Interface Speed In

14 Interface Speed Out

15 Interface Type

16 Location ID

17 Location Name

18 Model Details

19 Model Number

20 Protocol
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21 Utilization Threshold

22 Vendor Details

23 Vendor Name

Property information comes from the following sources:

• Protocol Configuration Table (update this using a form)

• Automatic feed from the network

• Common Property Tables batch-mode property import

• Common Property Tables “add new” and “update” forms 

• Interface Reporting batch-mode property import

• Interface Reporting change forms:

— Change Protocol Defaults

— Update Interface

— Change Interface Customer

— Change Interface Description

— Administer Interface Poll Flag

— Administration (Logging, Data Filtering, Provisioning)

Node-level properties and interface-level properties have different sources. Common Property 
Tables is the source for node-level properties. The change forms that come with Interface 
Reporting, and the batch-mode import that comes with Interface Reporting, are sources for 
interface-level properties.

If there is a customer and a location associated with a device, use Common Property Tables to 
assign the device to that customer and location. Once that step is done, interface-level 
properties will be inherited from the node level. For example, if you use Common Property 
Tables to assign a device to a customer, and then you import additional properties using the 
batch-mode property import that comes with Interface Reporting, any “unassigned interfaces” 
(interfaces not explicitly assigned to a customer) in your import file will automatically inherit 
the node-level customer.

When an interface is discovered, various attributes associated with that interface (speed, type 
and description) are sourced from the network. However, attributes sourced from the network 
are not always correct. The following properties may be incorrect:

• ifType

• ifSpeed

• ifDescr

To correct a property that is incorrect, you can either update a property import file, then 
import the file, or you can open a form, modify the contents of the form, and save your 
changes. 

If you set the Provisioning Mode to option 1, the property import file will not overwrite values 
for ifType, ifSpeed, and ifDescr that were sourced from the network. For details, see the 
section about Provisioning Mode options in Chapter 7, Change Forms. 
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Protocol-Specific Monitoring

The monitoring status parameter allows you to enable or disable interface monitoring based 
on the protocol. By default, all active (administratively up) interfaces with monitored 
protocols are polled, and all the polled data is stored, summarized, and reported. You can 
configure OVPI to disable collection for certain protocols. For example, if a device has ATM 
ports and frame relay ports and you are not interested in the frame relay ports, you can 
disable collection for the frame relay ports.

Switching off monitoring of a previously monitored protocol does not remove data from the 
database, but switching off monitoring will prevent new data for that protocol from being 
collected or inserted. If you switch off monitoring of a previously monitored protocol, 
previously collected data will eventually age out. To find out whether any interface data is 
being deliberately ignored as the result of marking a protocol unmonitored, look at the 
Configuration and Logging report in the Admin folder. 

For information about polling rules and how to stop the system from collecting data for ports 
with unmonitored protocols, refer to the Interface Reporting ifEntry Datapipe User Guide.

Batch-Mode Property Import

The purpose of the property data interface is to import property data into OVPI as a batch 
process and export property data from OVPI as a batch process. Batch mode would typically 
be used instead of forms when large numbers of interfaces need to be updated. 

When OVPI imports property data, the file that gets imported needs to adhere to a particular 
format; when OVPI exports property data, the file it produces is already in the proper format 
for you to modify and re-import. You can create an import file by:

• Building it from scratch using a spreadsheet application

• Exporting the required data, in the required format, from your provisioning database

• Letting OVPI collect property data, then exporting this data from OVPI

Since building a property import file from scratch is not easy, we recommend that you follow 
these steps:

1 Add devices to the system.

2 Allow the system to discover the interfaces on those devices.

3 Export existing property data from OVPI by typing this command:

trend_proc -f IR_exportdata.pro

4 Use the results as a starting point for your own modified property import file.

5 Store your modified file in the correct directory (where OVPI expects to find it) and import 
the file by typing this command: 

trend_proc -f IR_importdata.pro

The import command will import data from—and the export command will export data to—the 
following directory:

{$DPIPE_HOME}/data/PropertyData
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Property Import File

The following table describes the format of the property file. If you are creating this file 
yourself, make sure that your file adhere to this format. Your sequence of fields left to right 
must follow this sequence of attributes top to bottom and your attributes must be delimited by 
tabs, not spaces. If you are exporting this file from OVPI, the format will be correct.

Attribute Type Default Description

Device char_string,64 N/A Name of the device. A value for this attribute 
is required.

Interface char_string,128 N/A A unique identifier for the interface. A value 
for this attribute is required.

full_half integer 2 Denotes half duplex or full duplex:
1 =half duplex
2 = full duplex
Automatically populated from the Protocol 
Configuration Table if the value is NULL. 
Not automatically overwritten unless set to 
NULL.

ifType integer N/A The ifType as given by the ifTable on the 
managed device. Used as a cross-reference 
into the Protocol Configuration Table to 
determine the protocol and its properties. 

ifSpeed gauge N/A The ifSpeed as given by the ifTable on the 
managed device. 

ifSpeedIn gauge N/A The ifSpeed as given by the ifTable on the 
managed device. Can be changed to reflect 
the inbound speed on a dual speed interface. 
Used only for full-duplex interfaces.

ifSpeedOut gauge N/A The ifSpeed as given by the ifTable on the 
managed device. Can be changed to reflect 
the outbound speed on a dual speed 
interface. Used only for full-duplex 
interfaces.

ifDescr char_string,255 N/A The ifDescr as reported in the ifTable. 

cust_id seq_key -2 The customer identifier used to group 
interfaces by associated customer.

customer_name char_string,128 “Unknown 
Customer”

The customer name used to group interfaces 
by associated customer.

group_id seq_key -2 The group identifier for this interface. Not 
used explicitly.

group_name char_string,128 “Unknown 
Group”

The group name for this interface. Not used 
explicitly.

location_id seq_key -2 The location identifier used to group 
interfaces by physical location.
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Changing the Default Directory for PropertyData

The default directory for data property files, the location where the import utility will look for 
your edited files, is specified by the SourceDirectory path. This path appears in the following 
TEEL file:

IR_Property.teel

If you change the default directory before you install the Interface Reporting package, your 
task is easier, since you only have to change the path once, by finding the TEEL files in the 
Interface_Reporting.ap directory. If you want to change the default directory after installing 
Interface Reporting, you must make the path change in two places, namely:

location_name char_string,128 “Unknown 
Location”

The location name used to group interfaces 
by physical location.

country_code seq_key -2 The country code for this interface. Not used 
explicitly.

country_name char_string,128 “Unknown 
Country”

The country name for this interface. Not 
used explicitly.

UtilThreshold integer 10000 Utilization threshold. A percentage of 
available bandwidth, calculated as an 
average over the polling interval. Will 
auto-update from the Protocol Configuration 
Table only when this value is defaulted to 
10000 and the KIR_protocol_config value is > 
0.

ErrorThreshold integer 10000 Error threshold. Percentage of traffic with 
errors, calculated as an average over the 
polling interval. Will auto-update from the 
Protocol Configuration Table when the value 
is defaulted to 10000 and the 
KIR_protocol_config value is > 0.

DiscardThreshold integer 10000 Discard threshold. Percentage of traffic with 
discards, calculated as an average over the 
polling interval, at which an exception is 
counted. 
Will auto-update from the Protocol 
Configuration Table only when this value is 
at the default of 10000 and the 
KIR_protocol_config value is > 0.

AvailabilityThreshold integer 98 Availability threshold. A percentage of 
availability, calculated as an average over 
the polling interval, at which an exception is 
counted.
Will auto-update from the Protocol 
Configuration Table only when this value is 
at the default of 10000 and the 
KIR_protocol_config value is > 0.

Attribute Type Default Description
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• Interface_Reporting.ap

• {DPIPE_HOME}/lib

Changing the location of the PropertyData directory is not recommended. However, if you 
needed to change the directory location, follow these steps:

1 Create the new source directory.

2 Navigate to the appropriate directory (see the discussion above regarding which 
directories are involved) and open the directory.

3 Edit this file: IR_Property.teel

• Locate the SourceDirectory default path; look for the line beginning with 
SourceDirectory = 

• Change the path, replacing the existing path with the complete path name to the new 
directory; begin the new path name just after the equal sign ( = ). 

Adding Details about Vendors and Models

The Devices sub-package can recognize vendors and models based on the sysObjectId. You can 
add or modify the list using an import procedure that is similar to interface provisioning. 
Vendor details are stored in the following files inside the Interface_Reporting_Device.ap 
directory:

• vendor.txt 

• vendor_model.txt

Add rows, or modify existing rows, and then call this process:

trend_proc -f IR_Import_Vendor.pro

Vendor Properties

The following table provides a list of the available fields.

Leave the file filter as specified in the original SourceDirectory.

Column Type Default Comments

Vendor Name char_string,128 Required Field The name of the vendor. 
Example: “Cisco”

Vendor Details char_string,128 Required Field Additional details about all 
equipment from this vendor. 
Example: “Cisco Inventory”

Vendor sysObjectId char_string,128 Required Field The SNMP sysObjectId from 
the system group on the 
device.
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Model Properties

The following table provides a list of the available fields.

Column Type Default Comments

Vendor Name char_string,128 Required Field The vendor name.

Model Details char_string,128 Required Field Additional details about this 
model. 

Model sysObjectId char_string,128 Required Field The SNMP sysObjectId from 
the system group on the 
device.
Importing Properties 47



48 Chapter 5



6 Archiving Data
This chapter covers the following topics:

• Data Archiving

• View Current Retention Profiles List

• Enable Archiving

• Create a Custom Retention Profile

• View Archive Data Reports

Data Archiving

The data archiving feature allows you to store large amounts of data in archive tables without 
affecting the summarization and reporting performance of OVPI.

By default, archiving is disabled. When archiving is enabled, a data table becomes an active 
data table. Data is retained in the active table for a specified amount of time (defined in the 
retention profile) before it is moved to an archive table. An active table can archive data to one 
and only one archive table. 

When you installed the report pack, a retention profile was created for each data table (using 
information from the TEEL file). The retention profile defines the name and description of the 
retention profile, how long (in days) data remains in the active data table, how long (in days) 
data remains in the archive table, and if archiving is enabled. You enable archiving of a data 
table by modifying its retention profile. A retention profile can be assigned to more than one 
data table, but a data table can only have one retention profile assigned to it.

For more detailed information about data archiving, refer to the HP OpenView Performance 
Insight Administration Guide.

Data from an active table and data from an archive table cannot be displayed in the same 
report.
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View Current Retention Profiles List

To view all retention profiles:

1 Start the Management Console (log on with Administrator privileges).

2 Click the Tables icon in the navigation pane to display the Table Manager navigation pane.

3 Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles dialog 
displays the current retention profiles list. You can create, modify, and remove retention 
profiles from the Manage Retention Profiles dialog.

Enable Archiving

To enable archiving, either select a data table to modify its retention profile or modify a 
retention profile. A table has archiving enabled if the Archive On check box is selected in the 
Table Manager navigation pane.

Selecting a Data Table to Modify

To modify the retention profile of a selected table, do the following:

1 From the Management Console, click the Tables icon in the navigation pane to display the 
Table Manager navigation pane.

2 In the Table Manager navigation pane, double-click a table. The Data Table Details dialog 
displays.

3 Select the Retention Profile tab.

4 Modify any of the fields in the dialog.

5 Select the Archive On check box.

6 Click OK.

Modifying the Retention Profile

To modify a retention table, do the following:

1 From the Management Console, click the Tables icon in the navigation pane.

2 Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles dialog 
displays.

3 Select the retention profile to modify and click Edit.

4 Modify any of the fields in the dialog.

5 Select Yes in the Enable Archiving field.

6 Click OK.

You cannot modify the default profiles created during the product installation, remove a 
default profile, nor remove a profile that is in use.

You 

You cannot modify the default retention profiles created during the report pack installation.
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Create a Custom Retention Profile

To create a custom retention profile and assign it to a active data table, do the following:

1 From the Management Console, click the Tables icon in the navigation pane.

2 Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles dialog 
displays.

3 Click Create. The Create Retention Profile dialog displays.

4 Enter the following information: 

5 Click OK.

6 Assign the custom retention profile to a table:

a From the Management Console, click the Tables icon in the navigation pane.

b To filter the tables listed, you can select a specific category (such as 
Interface_Reporting) and/or a specific type (such as Rate) from the pull down lists 
above the list of tables.

c Select the table(s) to which you want to assign the retention profile

d Select File->Retention Profiles->Assign Retention Profile. The View Retention Profiles dialog 
displays.

e Select the retention profile you created.

f Click Assign Retention Profile.

Field Description

Profile Name The name of the retention profile. Maximum length is 64 
characters.

Retention Days The number of days to retain data in the active data table before 
moving the data to the archive data table. Select Yes for the 
permanently field if you want to retain all data in the active data 
table (do not move any data to the archive data table).

Archive Retention Days The number of days to retain data in the archive data table 
before the data is removed. Select Yes for the permanently field 
if you want to retain all data in the archive data table (do not 
remove any data from the archive data table).

Description A description of the retention profile. Maximum length is 255 
characters.

Enable Archiving? Default: No. Select Yes to enable archiving and create the active 
and archive data tables.
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View Archive Data Reports

Archive data reports are viewable anywhere active data reports are viewable (archiving must 
be enabled and there must be data in the archive data tables before you can view archive data 
reports). From the Web Access Server, the reports are available in the Archive folder.

Data from an active table and data from an archive table cannot be displayed in the same 
report.
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7 Change Forms
Interface Reporting includes multiple change forms. Use these forms to modify:

• Protocol defaults

• Interface speed and associated thresholds

• Customer, location, and interface description

• Directed-instance polling

• Logging level

• Data filtering

• Provisioning mode

Keep in mind that you cannot assign interfaces to customers or locations that are not already 
recognized by Common Property Tables. To add customers and locations to Common Property 
Tables, use the Create New Customer or Create New Location forms, or use the batch-mode 
property import that comes with Common Property Tables. For details, refer to the Common 
Property Tables 3.5 User Guide.

Changing Protocol Defaults

If you have not pre-provisioned new interfaces to configure specific thresholds and indicate 
whether they are full or half duplex, values for those variables will be pulled from the protocol 
configuration file as new interfaces are discovered and added to the system. You can add a 
new protocol to this file or you can modify the characteristics of an existing protocol.

Follow these steps to change the monitoring status or the default protocol thresholds: 

1 Select HP OpenView > Performance Insight > Management Console.

2 Click Objects and select any managed object. Forms appear under General Tasks.

3 Double-click Change Protocol Defaults. The form opens.

4 Select the protocol you want to change, then update Protocol Name, Monitor status, or 
Threshold percentage values as required.

5 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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The system will use defaults from the protocol table when:

• A just-discovered interface is inserted into the interface property table

• An existing interface has NULL values for protocol-related properties

• An existing interface has NULL values for protocol-related properties
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Changing Interface Properties

You can use the Change Interface Properties form to modify the following properties:

• Customer assignment

• Location assignment

• Utilization threshold

• Error thresholds

• Discard threshold

• Availability threshold

• Speed [In/Out]

This form is especially helpful when you want to change multiple properties for a single 
interface, or when you want to update multiple interfaces on a single device. If desired, you 
may use the Change Interface Properties form to update all the interfaces on one device in 
one operation; however, don’t forget that every interface will be updated to the same set of 
values, including speed and threshold settings. To access the form:

1 Select HP OpenView > Performance Insight > Management Console.

2 Click Objects, then navigate to and select the interface you want to update. Or, to update 
all the interfaces on a device, select the device. You will see Change Interface Properties 
listed under Object Specific Tasks.

3 Double-click Change Interface Properties. The form opens.

4 Select an interface, then update assignments, thresholds, speeds, or duplex values as 
required.

5 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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Changing Customer and Location

The Change Interface Customer and Change Interface Location forms allow you to assign 
interfaces to a customer or a location. These forms can be used to update a single interface, or 
to assign all the interfaces on a device to single customer or location.

To change the customer or location assignments, follow these steps: 

1 Select HP OpenView > Performance Insight > Management Console.

2 Click Objects, then navigate to the interface you want to update, and select it. You may 
also select a device, if you want to update all the interfaces on that device. The forms 
appear under Object Specific Tasks.

3 Double-click Change Interface Customer or Change Interface Location. The form opens.

4 Use the selection list to update the assignment.

5 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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Changing the Interface Description

If you want to change the description of an interface, follow these steps:

1. Select HP OpenView > Performance Insight > Management Console.

2. Click Objects.

3. Navigate to the interface you want to update, or the device for which you want to update 
one or more interfaces. The Change Interface Description form is listed under Object 
Specific Tasks.

4. Double-click Update Interface Description. The form opens.

5. Select the interface you want to change, then update the description as required.

6. If you selected a device and opened this form, all the interfaces on the device will appear 
in the table. You can update the descriptions for multiple interfaces by selecting one, 
updating the description and clicking Apply, and then repeating.

7. Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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Configuring Directed-Instance Polling

The Interface Reporting ifEntry Datapipe supports five polling rules. One of the supported 
rules, Poll Flagged Interfaces Only, permits collection from selected interfaces only, namely, 
interfaces that have a poll flag set. There are several methods to set the interface poll flag. One 
method is to use the Administer Interface Poll Flag form.

Follow these steps to set the interface poll flag using the Administer Interface Poll Flag form: 

1. Select HP OpenView > Performance Insight > Management Console.

2. Click Objects.

3. Navigate to the device you want to update and select it. The Administer Interface Poll 
Flag form appears under Object Specific Tasks.

4. Double-click Administer Interface Poll Flag. The form opens.
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5. Select the interfaces you want to change, then update the description as required. You can 
select multiple interfaces by using the CTRL or SHIFT keys.

6. Select the required poll flag setting, On or Off.

7. Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.

Data Filtering, Provisioning, and Logging Level

Data Filtering

Provisioning Mode

Logging Level

Option Impact

0 The default. Data for all collected interfaces is transferred 
from the datapipe to the report pack. If new devices or 
interfaces are discovered and polled, property rows for those 
devices and interfaces will be added in the report pack.

1 Only data for provisioned interfaces will be transferred to 
the report pack. Data collected for interfaces that are not 
already provisioned in the report pack will be discarded.

Option Impact

0 The default. Values for Interface Speed, Type, and 
Description collected from the network do not overwrite 
provisioned settings. If a new interface is discovered, and 
this interface is not provisioned in the report pack, these 
attributes are set once from collected data.

1 Values for Interface Speed, Type, and Description collected 
from the network overwrite provisioned settings. If you use 
property import to import values, ifSpeed, ifType, and 
ifDescr will not be updated.

Option Impact

0 Errors only

1 The default. Standard level of logging.

2 Maximum level of logging.
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Changing Settings

To change settings for data filtering, provisioning, or logging level follow these steps: 

1. Select HP OpenView > Performance Insight > Management Console.

2. Click Objects and select any managed object. Forms will appear in the General Tasks 
window.

3. Double-click Administer Interface Reporting. The form opens.

4. Select the administration setting you want to change, then select the new setting.

5. Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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8 Spotting High Exceptions
Interface Reporting provides five reports that help you focus on high exception counts:

• Exception Hot Spots (Exceptions sub-folder)

• Device Exception Hots Spots (Device folder)

• Trunk Exception Hot Spots (VLAN folder)

• VLAN Exception Hots Spots (VLAN folder)

• EtherChannel Exception Hot Spots (EtherChannel folder)

The Exceptions Hot Spots sorts interfaces by exception count, highest to lowest. The selection 
table is followed by three graphs:

• Exception counts (hourly / daily / monthly)

• For each exception type, the average, maximum, and threshold for the previous 30 days

• Daily averages for each exception type, for each traffic direction

The first graph will tell you whether the exception activity is relatively static, caused by one 
type of exception, or variable, caused by multiple types of exceptions. The second graph makes 
it easy to compare exception activity to the threshold. The third graph looks at utilization, 
discard, and error exceptions as a percentage of available bandwidth. When the interface is 
full duplex, you can view data for inbound traffic and data for outbound traffic.

The device version of the report is similar. It sorts initially by customer, then by device, and 
aggregates data at the device level. Use this report to identify the devices that are generating 
the most exceptions. The selection table is followed by three graphs:

• Exception counts (hourly / daily / monthly)

• For each exception type, the average, maximum, and threshold for the previous 30 days

• Daily averages by exception type

Samples of the following reports follow:

• Exception Hot Spots 

• Device Hots Spots 

• Trunk Exception Hot Spots 
  63



64 Chapter 8



Spotting High Exceptions 65



66 Chapter 8



Spotting High Exceptions 67



68 Chapter 8



Spotting High Exceptions 69



70 Chapter 8



9 Exceptions by Type
Interface Reporting looks at exceptions in two ways, by count and by type. You can look for 
interfaces and devices with the highest exception counts for yesterday, or you can look for 
interfaces that produced a particular type of exception. If the exception count is what 
interests you, use the Hot Spots reports. If the type of exception is what interests you, you 
have three choices:

• Discard Exceptions

• Error Exceptions

• Utilization Exceptions

The format for all three reports is similar: 

• Selection table that ranks interfaces by exception count

• Bar chart showing total exceptions (hourly/ daily/ monthly)

• Line graph comparing maximum, average, and threshold 

• List of recent maximum rates, with date and time stamp 

The selection table looks at yesterday’s activity and shows the exception count, the speed of 
the interface, and threshold setting for each type of exception. (Threshold values are set to 
defaults; these values can be changed by modifying a form or by importing a property file that 
contains updated threshold values.) 

The first graph tracks exception counts; the hourly graph covers the previous two days, while 
the daily graph covers the previous 30 days. If yesterday’s exception count seems abnormal, 
compare it to the daily graph to get a sense of what has been normal in the past. The second 
graph allows you to compare average and maximum values to the threshold. 

Below the graphs is a list of recent maximum rates, date stamped so that you know exactly 
when the maximum was recorded. Use this list to compare yesterday’s total to previous totals 
and to see whether the maximum rate has been occurring at the same time of day. 

Samples of all three exception reports follow.
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10 Locations and Protocols
Interface Reporting includes two summary reports. One offers a location perspective on 
performance, rolling up performance data by location, and the other offers a protocol 
perspective on performance, rolling up performance data by protocol. The key metrics in both 
reports are volume, exceptions, and utilization.

Summary reports provide aggregated data across multiple systems. The location summary 
report provides the following information:

• Number of active, monitored interfaces by location

• Volume for one customer by location

• Volume for all customers by location

• Hourly, daily, and monthly analysis of exception counts by location

• Hourly, daily, and monthly utilization by location

The protocol summary report provides the following information:

• Number of active, monitored interfaces by protocol

• Volume for one customer by protocol

• Volume for all customers by protocol

• Hourly, daily, and monthly analysis of exception counts by protocol

• Hourly, daily, and monthly utilization by protocol

You may investigate a location customer-by-customer, or you may investigate a location by 
looking at performance data for every customer at that location simultaneously. Similarly, you 
may look at the performance of a protocol for one customer, or for all customers. 

Use summary reports to find out how the number of actively monitored interfaces compares 
location to location, or protocol to protocol, and to compare exception counts location to 
location or protocol to protocol. If a customer needs an upgrade, or if a location needs an 
upgrade, the summary reports should make that clear. In addition, if a recent upgrade at one 
location was expected to lower the exception count for that location, the location summary 
report should provide the evidence you need to verify that the situation has improved.

Both summary reports are reproduced below. 
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11 Capacity Planning
In addition to monitoring the exceptions created by occasional spikes in traffic, Interface 
Reporting is concerned with gradual increases in utilization and the resulting capacity 
problems that may arise a few months from now. Interface Reporting includes the following 
capacity planning reports: 

• Capacity Planning by Interface (Busy Hour)

• Capacity Planning by Device

• Capacity Planning by Location 

• Capacity Planning by Protocol

The interface version of the report focuses on the baseline busy hour average (a rolling 
average of 42 busy hours) and projected increases or decreases in the baseline busy hour 
average. The selection table sorts interfaces by the F30 forecast for the baseline busy hour 
and allows you to compare the following statistics for each interface:

• Baseline busy hour

• F30 forecast for baseline busy hour

• Utilization threshold

The baseline busy hour will change slightly every day, since, each day, the oldest busy hour 
value will be dropped from the average, while a new busy hour (for yesterday) will be added to 
the average. Note that the value for each busy hour is itself an average (based on four 
samples) and should not be confused with peak usage. For a portion of that busy hour, actual 
usage may have been much higher (or much lower) than the average. 

The other three capacity planning reports are customer-oriented, so your first step is to select 
a customer. The selection table will then rank the elements (devices, locations, or protocols) 
belonging to that customer. The ranking is done according to rate of growth and the rate of 
growth is calculated by dividing the F30 forecast by the baseline busy hour. In all four 
capacity planning reports, the graphs beneath the selection table provide additional forecast 
data (baseline details, the F60 value, the F90 value, and day-of-week values) and a Grade of 
Service score that assesses the impact of discard, error, and utilization exceptions.

Samples of two capacity planning reports follow; the first report is from the Interface folder, 
the second report is from the Device folder.
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12 Service Level Management
Service level agreements between service providers and customers commonly stipulate a 
minimum response time and minimum availability. The purpose of the Service Level 
Management (SLM) reports is to improve service level monitoring for both parties, enhancing 
precision and making violations easier to spot. 

SLM reports focus on SNMP response time and availability. Response time measures delay 
within the management infrastructure, that is, delay between the datapipe and the device 
being polled, not delay between clients and servers. While you would not want to infer from a 
high SNMP response time that users are seeing the same delay, the response time that users 
are seeing could be similar if the device is the source of the delay.

Availability measures the percentage of time a device has been operational. This metric 
provides insight into device outages as reported through the SNMP sysUpTime attribute. To 
calculate the availability of individual interfaces, OVPI combines the sysUpTime value for the 
device with two interface attributes, ifOperStatus and ifLastChange.

Use the SLM reports to identify specific interfaces, devices, protocols, and locations that are 
experiencing availability or response time problems. The report in the Interface folder is 
interface-oriented, beginning with a list of device/interface combinations; the other SLM 
reports are customer-oriented, allowing you to select a customer/element combination. 

The initial selection table looks at yesterday’s availability, and ranks items by availability, 
lowest to highest. Use the graph to the right to view availability on an hour by hour basis, 
then compare the hourly graph to the daily graph to find out whether yesterday’s activity was 
an isolated incident, not likely to occur again, or part of an ongoing trend. The second table, 
response time, looks at yesterday’s response time and ranks items by response time, highest 
to lowest.

Interface Reporting includes four Service Level Management reports. Two samples follow, one 
from the Interface folder and one from the Device folder.
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13 Administration Reports
The following table outlines the scope of each admin report.

Admin Report Information Provided

Configuration and Logging • Configuration settings for:
— Logging level
— Data filtering
— Provisioning.

• List of recent log entries
• Entries are listed by component
• Each entry is time-stamped
• Each entry indicates duration in seconds
• IR_map_p is the most common component
• The number of entries per poll (two entries per poll in 

the sample report) is related to number of index types

Inventory • List of customers
• List of devices for each customer
• IP address, make, model, description
• List of interfaces on each device
• Attributes for each interface:

— AdminStatus
— Protocol
— Full/Half
— Speed
— Threshold
— Description

Top Level Inventory • Total number of devices for each customer
• Total number of interfaces for each customer
• List of devices by make and model
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See below for samples of these reports:

• Configuration and Logging

• Inventory

• System Performance

System Performance Processes that took place during the last 2 hours:
• Name
• Start time
• Duration
• Rating
• Bar chart showing duration of each process in seconds
Processes that took place since yesterday:
• Name
• Start time
• Duration
• Rating
• Bar chart showing duration of each process in seconds

Admin Report Information Provided
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A Version History
The following table describes the history of enhancements to the Interface Reporting 
Report Pack.

Version Release Date Enhancements

2.0 January 2002 Sybase support

2.1 January 2003 Minor fixes and changes

3.0 May 2003 OVPI Object Manager support
new change forms:
• Change Protocol Defaults
• Update Interface
• Change Interface Customer/Description
• Administer Interface Poll Flag
• Administration

3.0 October 2003 new sub-packages:
• Etherchannel
• VLAN
Cisco VLAN Datapipe 2.0

4.0 April 2004 Oracle support

4.5 August 2004 new form: Assign Priority 
new folder: Vendor
new reports: 
• Top Level Inventory [Admin folder]
• Priority Customer [multiple]

new upgrade packages:

• UPGRADE_Interface_Reporting_4_to_45.ap
• UPGRADE_Interface_Reporting_Device_4_to_45.ap
• UPGRADE_Interface_Reporting_Location_4_to_45.ap
• UPGRADE_Interface_Reporting_Protocol_4_to_45.ap
• UPGRADE_Interface_Reporting_Vlan_3_to_45.ap
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4.6 November 3004 new features:
• Constraints on exception reports removed
• Default for Ethernet changed to full duplex
• Cisco 806 added to vendor table
• VLAN report statistics refreshed
• Cisco VLAN Datapipe 2.1
new upgrade packages:
• UPGRADE_Interface_Reporting_45_to_46.ap
• UPGRADE_Interface_Reporting_Device_45_to_46.ap
• UPGRADE_Interface_Reporting_Location_45_to_46.ap
• UPGRADE_Interface_Reporting_Protocol_45_to_46.ap
• UPGRADE_Interface_Reporting_Vlan_45_to_46.ap

5.0 June 2005 new features:
• Report linking
• Launch Point page
• Ad hoc selector reports
• Color-coded graphics in selection tables
new report:
Utilization and Volume
new upgrade packages:
• UPGRADE_Interface_Reporting_to_50.ap
• UPGRADE_Interface_Reporting_Device_to_50.ap
• UPGRADE_Interface_Reporting_Location_to_50.ap
• UPGRADE_Interface_Reporting_Protocol_to_50.ap
• UPGRADE_Interface_Reporting_Vlan_to_50.ap

5.1 May 2006 Structure of KIRDevports table changed to accommodate 
ifAlias
new upgrade package:
• UPGRADE_Interface_Reporting_50_to_51
defect fixes for these datapipes:
• Interface Discovery Datapipe 2.3
• Interface Reporting ifEntry Datapipe 2.3

5.2 April 2007 new features:
• Location Independent Reporting
• Copy Policies
• Rate data removed from top table, NRT
• Report format updates
• Long Term Retention (data archiving)
• Object delete

Version Release Date Enhancements
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5.2 April 2007 new upgrade packages:
• UPGRADE_Interface_Reporting_to_52.ap
• UPGRADE_Interface_Reporting_Device_50_to_51.ap
• UPGRADE_Interface_Reporting_Location_50_to_51.ap
• UPGRADE_Interface_Reporting_Protocol_50_to_51.ap
• UPGRADE_Interface_Reporting_Vlan_50_to_51.ap
• UPGRADE_CiscoVLAN_Datapipe_to_22.ap
• UPGRADE_IFEntry_Disc_Datapipe_to_24.ap
• UPGRADE_IRifEntry_Datapipe_to_24.ap
• UPGRADE_IR_OPNET_Export_Datapipe_to_21.ap
defect fixes: 
• QXCR1000230043
• QXCR1000295655
• QXCR1000326913
• QXCR1000334215
• QXCR1000341512
• QXCR1000353083
• QXCR1000367521
• QXCR1000367745
• QXCR1000394448

Version Release Date Enhancements
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B PI Report Packs
Business Technology Reporting Solution

Application Application Report Pack:
• WebLogic SPI
• WebSphere SPI

Database Database SPI Report Pack

HP Business Process Insight BPI Report Pack

HP Internet Services Internet Services Report Pack

HP Network Node Manager NNM Event & Availability Report Pack

HP Operations OVO Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN MPLS VPN Report Pack

Networking Infrastructure Usage

• Interface Reporting
• Device Resource Report Pack

LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)

Traffic Profiling

• RMON II

• NetFlow Interface

• NetFlow Global View

• IP QoS Report Pack

• Class-Based QoS
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Networking (continued) Quality Assurance

• Cisco Ping Report Pack
• Service Assurance
• IP Access Rate

System Resources • System Resource Report Pack

Business Technology Reporting Solution
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C Editing Tables and Graphs
Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary
availability

The percentage of time a device has been operational. Identifies device outages as reported 
through the sysUpTime variable. Calculated by combining device sysUpTime with interface 
ifOperStatus and interface ifLastChange. 

avg volume

This metric is found in capacity planning reports. It refers to average daily volume during the 
baseline period.

baseline busy-hour

This value is the average of 42 busy-hour values recorded during the rolling baseline period. 
This value is static for one day only. It will be different tomorrow, when yesterday’s busy hour 
is factored into the calculation that determines average Busy Hour. Baseline busy hour and 
forecasts for future baseline busy hour values appear in capacity planning reports. 

busy-hour

This value reflects a relatively persistent phenomenon and, when combined with multiple 
busy-hour values over the baseline, is used to predict future performance. The busy hour 
value is an average of multiple samples taken during the hour. Do not confuse busy-hour with 
peak. During the busy hour, actual utilization can be significantly higher than the busy-hour 
average. 

country

This value is imported by the provisioning interface. If not provisioned, the field reads 
unknown.

daily

A view showing daily performance for the previous 31 days. The most recent day in this view 
is yesterday.

day of week

A forecast, derived from baseline data, that assigns a growth rate to each day of the week. 

discard rate

The percentage of packets discarded by the interface. Data about discards is sampled during 
each poll cycle (by default this is four times an hour); based on those samples, OVPI calculates 
an average and a maximum discard rate. 
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discard threshold

The point at which an acceptable percentage of discarded traffic becomes an abnormal 
percentage and possibly impacts response time. If the interface is full duplex, the same 
threshold value is applied to both in and out packets separately.

error rate

The percentage of packets with errors as reported by the interface. Data about errors is 
sampled during each poll cycle (by default this is four times an hour); based on those samples, 
OVPI calculates an average and a maximum error rate. 

error threshold

The point at which an acceptable percentage of errored traffic becomes an abnormal 
percentage and possibly impacts response time. If the interface is full duplex, the same 
threshold value is applied to both in and out packets separately.

F30 / F60 / F90

The level where utilization (or volume) is expected to be 30, 60, and 90 days from now. 
Calculated by applying linear regression to busy-hour levels over the baseline period.

group

This value is imported by the provisioning interface. If not provisioned, the field displays 
unknown.

growth rate

F30 utilization divided by average busy-hour.

hourly

A view showing performance for the last two days and whatever portion of today has elapsed. 
The minimum time range is 48 hours; the maximum is 72 hours. 

interface

An entry in the SNMP ifTable for the device, representing a physical or a logical interface.

location

This value imported by the provisioning interface. If not provisioned, the field reads unknown.

monthly

A view showing performance for each month over the last two years. Blank until data 
collection has been functioning for at least one month.

protocol

The textual name associated with the enumerated ifType of the interface.

response time

Delay within the network management structure, specifically, delay between the datapipe and 
the device. If the device is causing the delay, this value may point to device resource issues.
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threshold

The line between normal and abnormal performance. When this line is crossed, an exception 
is recorded. Thresholds are set to default values that are easily changed to reflect individual 
needs. 

utilization

The total number of octets traversing the interface as a percentage of the total possible 
number of octets, using the ifSpeed property. If an interface is full duplex, the table displays 
utilization in each direction. Groups of interfaces have their utilization calculated by taking 
the total traffic on all administratively up interfaces in the group and dividing that by the 
total possible bandwidth. Utilization for a group of interfaces is more reliable when all the 
interfaces in the group use the same protocol.

utilization threshold

The point at which the number of octets traversing the interface is considered detrimental to 
the service level required by network users. In the case of full duplex interfaces, the same 
threshold value is applied to in and out packets separately.
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